
David Lenderman Dives into Digital February 6th

Bali & Beyond 
Plus Digital Wide-Angle Digital Techniques

By Dennis Deavenport

There's a lot to say about David and it's just 
about all good and worth repeating.  How-
ever, jumping into the forefront of digital 
UW photography wasn't on this list until 
the tail end of 2005.  As is typical for 
David, once committed to a course of ac-
tion, he digs in with both feet and takes it 
in big chunks.  On last November's trip to 
Komodo on the Komodo Dancer, he 
packed a nice assortment of digital still and 
video gear.  His new equipment, a Nikon 
D100 in an Aquatica Housing (with a 60 
mm lens for macro and 10.5 mm fisheye 
lens for WA) and a Sony PC110 in an 
Ocean Images Housing for digital video, 
gave him a good workout swapping back 

and forth from one dive to the next.  His 
ambitious presentation will feature a pro-
gram set to music that incorporates both 
still shots and video segments.  Although 
this is the first time for David to put to-
gether a digital show, we've all come to 
expect a thoroughly entertaining and edu-
cational evening.  

As a nice bonus, David has also put to-
gether a short program on wide angle tech-
niques.  Judging from the awesome WA 
images that we've seen him produce in 
35mm slide format, we should all be in for 
a special treat.  He will discuss some of the 
special lighting problems that have to be 
overcome when using a 10.5 mm fisheye 
lens that covers an angle of 180°.  Also on 

his list will be tips on selecting good sub-
jects and how to set up and execute “close-
focus, wide angle” photos.  It will be an 
opportunity to learn how to shoot wide 
angle images from one of HUPS' best.

You'll not want to miss this program.  It's a 
dead-solid guarantee to be awesomely en-
tertaining and solidly educational.  The 
meeting will take place Monday, February 
6th at the Bayland Community Center.  A 
map showing how to get there is on the 
back page of the newsletter.  Looking for-
ward to seeing you there.  As always the 
meeting will be held at the Bayland Com-
munity Center on Bissonnett.  A map can 
found on the back page of this newsletter.  
See you there!
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January Meeting Recap -

HUPS' 2006 season was inaugurated in high style with a dual program presented by Ned Shimizu and Tom Collier.  At the alpha-
predator end of the scale, Ned gave us a program that we could all “sink our teeth into”.  His show featuring the great white sharks sur-
rounding Isla Guadalupe, 22 hours SW of San Diego, was very different in a number of interesting ways.  Not only was Ned taking pic-
tures inside a cage but he was out in blue water.  Taking pictures of great whites requires different techniques that he was happy to de-
scribe.  However, the real fun started when Ned, a dentist, started discussing the “gummy grimaces” that great whites display when go-
ing for a bite to eat.  Obviously, Ned feels that they need the help of a good dentist to fix their nasty smiles.  It was good fun for every-
one and a chance to see some fascinating digital photographic work.

Tom Collier, with some help with images from Jackie and Mary Lou Reid and Ken Knezick, put together an absolutely top-notch show 
on the omega-weird critters found in the black-sand waters of Lembeh Straight (Sulewesi, Indonesia).  It was obvious from the first that 
we were in good hands.  Tom put together a superb Proshow Gold presentation displaying the sublime pleasures of diving in the waters a 
few steps away from the world-class Kungkungan Bay Resort.  Top-side and underwater, the scenery is awe-inspiring and Tom's pro-
gram set to music presented it in a finely-crafted show.  If you want to experience KBR and see it first hand, all you need to do is talk to 
Tom about the Island Dreams/HUPS dive trip leaving April 15th.  I'm not about to miss the fun and I hope to see you there, too.
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President’s Message
Dive Safety & UW Photography go Hand & Hand

As underwater photographers we all strive to get that image we 
are so proud of.  Sometimes in the process we lose sight of 
something very important, safety.  One of the first things you 
learn as a new diver in your open water class is the parameters in 
which we all learn to live.  I remember when I became certified 
and I expressed an interest in underwater photography, my in-
structor was quick to point out that first and foremost you need 
to become a safe and good diver.  After you become proficient at 
that then you can pick up a camera.  That has always stuck with 
me. 

Dive safety is always first.  Never jeopardize that for the shot.  It 
is so easy to get caught up in the viewfinder and disregard your 
gauges and computer.  This is becoming ever more important 
with the advancement of Digital Photography.  Now that we 
have, what seems like “endless film”, we tend to spend more 
time at depth than ever before.  Where as before, I could shoot a 
roll of film and was ready to ascend with plenty of time and gas 
left.  It seemed like it wasn't long before I was out of film.  Now 
with the Digital Memory, I went from 36 exposures to well over 
150… so you can see where we are headed here… BE CARE-
FUL.  Always be mindful of your depth and time.  Always allow 
for a slow ascent and safety stop of at least 3 to 5 minutes.  
There are plenty of nice things to photograph on your ascent.  I 
always try to stay shallow and plan a profile that allows for a 
gradual ascent.  If I'm going after a pigmy seahorse at 110 ft then 
I descend to that depth, capture the image and then make a grad-
ual ascent along the wall, stopping briefly to off-gas and shoot 
that beautiful nudibranch at 40ft.  By doing this, you can use 
your photography to make your dive safer.  I also dive Nitrox to 
make my dive safer.  There is special training required to use this 
blend of Safe-Air but I would highly recommend it.  As for me, I 
am less tired and it adds a little built in safety margin when it 
comes to Decompression Sickness. 

With all of the remote diving locations and Live-Aboards seem-
ingly becoming more popular, it is extremely important to be 
safety conscious as Recompression Chambers are not always 
easily or readily accessible.  Not only are you subjecting your-
self to problems but the others on the trip with you.  We all love 
to show our images and work hard to get them.  Just remember 
to plan a safe dive profile and stick to it as the images won't be 
of any value if your not here to enjoy them…..

Dive Safe!
Chuck 

HUPS Travel Update

By Tom Collier, HUPS Trip Coordinator

April 13-23, 2006
Lembeh Strait, North Sulawesi, Indonesia
Six days of diving:  3 boat dives per day + 1 boat night dive + 1 
shore night dive + unlimited day shore diving on the house reef 

at Kungkungan Bay Resort  KBR has a great website, check it 
out:  http://www.kungkungan.com/.

New trip extension option:  Four additional nights in Indonesia 
at Gangga Island Resort for superb blue-water diving and wide-
angle photo opportunities.  This resort is located on a small is-
land a short boat ride from Lembeh Strait.  Here we will dive 
sites on Bangka Island, Gangga Island and Bunaken National 
Marine Park.  The resort features a spa and luxurious Minahasa-
style bungalows overlooking the beach and neighboring islands.  
Offered is 8 boat dives + 1 night dive.  With this option we will 
be returning to Houston on April 27th.   Check out the website, 

http://www.ganggaisland.com/.

Latest info:  Island Dreams has 7 spots open. Call Tina at Island 
Dreams Travel:  (713) 973-9300, (800) 346-6116 to reserve your 
spot.  KBR & Lembeh = $ 2,975.00 + additional changes in cost 
of airfare.  Gangga Island add-on = $ 765.00.

September 9-10, 2006 
Digital Photo Workshop at the Flower Gardens
HUPS will be hosting a Flower Gardens digital photography 
workshop in September 2006.  James Wiseman will be present-
ing a series of lectures covering digital photography topics such 
as gear selection and setup, digital photo underwater techniques, 
topsides image processing, and image archiving

Latest info:  We have 10 spots available for this trip and they 
will go fast.  (Actually only 9 spots, as James will occupy 1 
spot.)  If you would like to participate in this workshop please 
mail your deposit as soon as possible.  We will fill the trip on a 
first come, first served basis.

$405.00 = Trip cost ($65.00 extra for Nitrox).  $50.00 = Deposit 
required to reserve your spot.  Mail Deposit = Tom Collier, 1806 
Buchanan St., Brenham, Tx  77833.

Summer 2007
The HUPS Board of Directors voted on the Caribbean area as 
our destination for 2007.  We will be investigating both live-
aboard and land based options.  Suggestions are welcome.

We are working on scheduling at least one trip a year for HUPS 
travel.  Discounts for group travel can be obtained, depending on 
where we go and the size of our group.  Your suggestions for 
future trip locations are welcome.

HUPS Trip Coordinator:  Tom Collier, tom@tpixs.com

Membership Renewal for 2006

For only $30 per individual or $35 per family, you can renew 
your membership for 2006.  If there are no address, phone or 
email changes, just bring or mail a check to Jean Himes, 6723 
Imperial Leaf Lane, Spring, TX 77379.  To receive the monthly 
newsletter, be sure to give your current email address along 
with your dues.  Renewal forms will be available at the door of 
the February meeting. 

♥Happy Valentine’s Day♥
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How to be a Good UW Photographer?
Part One - Have Good Buoyancy Control
By David Lenderman

Last month I completed a four part series on traits that make up 
a good photo.  The next obvious thing to do is to address what 
club members can do to get those good photos.  So, this article 
starts a multipart series on what an underwater photographer 
has to do to get consistently good images.  There are lots of 
things that go into making a good photographer.  I will try to 
cover the points that you MUST do to be a good photographer.

Good buoyancy control - This is a big one and the most impor-
tant.  It is absolutely impossible to get consistently good images 
if you have poor buoyancy control.  Being able to hover without 
flapping hands or kicking is essential to getting good photos.  
This is the only way to get close, in focus shots.  Many photog-
rapher who think they have focus issues actually have buoyancy 
issues.  How can you get properly composed and in focus shots 
if you are flapping around trying to get the shot?  If you have 
poor buoyancy control you will scare off your subjects, kick up 
sand and damage the reef.  That is not good for your photos, 
your dive buddies or the reef.

So how do you get good buoyancy control?  Part of it comes 
with experience, but I have seen people that have been diving for 
years with absolutely no grasp of buoyancy control.  The first 
step is proper weighting.  If you seem to be constantly sinking to 
the bottom or must always kick to keep yourself off the bottom 
then you are most likely over weighted.  Try removing a couple 
pounds from your weight belt.  You only need enough weight to 
keep yourself neutral on your safety stop with 500 psi in your 
tank and no air in your BCD.  If you find that you need air in 
your BCD with a near empty tank on your safety stop then you 
should remove some weight from your belt.  The second step to 
neutral buoyancy is to use your BCD for its intended purpose.  
When you get near the bottom at the beginning of your dive put 
some air into your BCD until you feel it very slightly start to 
float off your shoulders.  Please note that I said “near the bot-
tom”.  Don’t wait until you hit bottom to add air to your BCD.  
As you see the bottom approaching begin adding air to slow and 
finally stop your descent.  On numerous occasions I have seen 
divers kicking the entire dive to stay off the bottom while all 
they had to do was add a little air to their BCD.  Remember it is 
called a Buoyancy Compensating Device.  Use it to do its job.

If you are struggling with your buoyancy take a buoyancy class 
at a local dive shop or resort.  A quick glance at the PADI web-
site shows they offer a specialty called Peak Performance Buoy-
ancy.  You photos will improve, your air consumption will be 

better, your dive buddies will love you more and the reef will be 
healthier.  What more could you ask for?

Monthly Contest Results 
January: Real Little
Digital - Advanced
1st -David Lenderman
2nd - Mary Lou Reid
3rd - Tie - Ken Knezick, David Lenderman

Digital - Novice
1st Dan Brady
2nd  Jim Mensay
3rd  Anita Brady

Slides - Combined
1st Mary Lou Reid
2nd  John Ringrose
3rd  Jackie Reid

Red - Like a Valentine Heart  ♥
Because the month of February includes Valentine’s Day we 
thought it was fitting to have the color red as our contest subject 
this month.  So if you have some images that you love with all 
your heart of subjects that are primarily red in color be sure to 
enter them in the contest.

At monthly meetings we will have both slide and digital con-
tests.  Entries for the slide contest should be brought to the meet-
ing.  Entries for the digital contest should be emailed to 
photocontest@hups.org at least 24 hours prior to the meeting.  
This mailbox is reserved for entries only.  If you have a question 
regarding the digital contest email ddeavenport@houston.rr.com 
or james@reefs.org .  Complete contest rules can be found at 
http://www.hups.org/contestr.htm.  If you do not follow the rules 
for digital entries your images will not be judged.
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Upcoming Monthly Photo 

Contest Topics
Each month we will have digital and slide con-
tests.  For complete contest rules checkout: 
http://www.hups.org/contestr.htm

February -  Red as a primary color 

of the subject

May - Texture and Color

March -Leading Lines June - Anemones and things that 

live in them

April - Put Away that Strobe - Natu-

ral Light

July - Shoot your Buddy - Shots 

with divers

Travel Tip
When flying try to carry on your camera gear.  You can 
always rent scuba gear or even buy new clothing at your 
destination if your checked bags are lost by the airline.  
Camera gear would be the most difficult and expensive to 
replace at some exotic locale.  You would be surprised how 
much photo gear will fit into a rolling carry on bag.



Selective Enhancement of Images - Part II
By Pat Miller - HUPS Webmaster

Now, let’s get to a more interesting, “artistic” application.  Say I 
have a picture of a blue ribbon eel from the muck at the bottom 
of the Lembeh Strait in Indonesia, a little guy just a couple of 
inches long.  And I feel like the picture could benefit from de-
emphasizing the sandy bottom near the eel, trying to make that 
space more negative in relation to the primary subject.  Here’s an 
image after just a little application of Levels to brighten the mid-
tones a bit and Curves to increase contrast slightly:

The first thing I’ll do before any more editing is duplicate the 
layer, and you’ll see why in a second.  Your image editing appli-
cation does feature layers like Photoshop and Paint Shop Pro, 
doesn’t it?

Then using Photoshop’s Lasso tool  I select the left side of the 
image:

I intend to darken and blur the left side of the image a bit to de-
emphasize it, to make it more into negative space, to allow more 
attention to be focused on my primary subject, the eel.  I try to 
follow along some of the contours in the image so my changes 
will look natural.  I don’t need to be too precise right now, and 
you see my selected region overlaps the eel somewhat, because I 
am only editing the top layer.  You’ll see why in a second.  If 
your imaging application doesn’t allow the use of layers, you 

will have to be more precise and draw your selection away from 
your primary subject, so you do not edit your primary subject.

After selecting the area I want to darken, I feather the edge of 
my selection by some number of pixels (in Photoshop it’s under 
Select -> Feather. . .).  Feathering softens the edge of the selec-
tion, and allows the changes I make to be applied gradually from 
the edge of the selection so it blends with the unselected part of 
the image.  How many pixels you enter as the “Feather Radius” 
depends on your image and it’s size in pixels – how wide you 
want the transition region between edited and unedited to be.  I 
decide to feather by approximately the width of the eel.

Now, making sure I am editing the top layer, I use Curves to 
darken the selected part of the image.  Alternatively I could use 
Levels, but Curves gives me more control.  And then I use Pho-
toshop’s Gaussian Blur Filter (Filter -> Blur -> Gaussian Blur. . 
.).  It’s best to have the image magnification at 100%, or close to 
100%, when you are deciding how much blur to add.  And then I 
use Hue/Saturation to desaturate, to turn down the color a little 
bit.  (In Photoshop, I hide and make visible again the selection 
edges -  the “marching ants” -  by clicking on View -> Extras or 
View -> Show -> Selection Edges, to help see what the changes 
look like before I click OK in a tool to apply the changes.)

Since my selection included a bit of the left side of the eel and I 
feathered by a good number of pixels, I have changed not only 
the negative space but also part of the eel.  But I only edited the 
top layer “Background copy” in the layer stack-up shown below. 
 I have not touched the original bottom layer.

 

We will finish up with this example next month.
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New Novice Digital Category
You have been asking for it and now you have it.  A NOVICE 
category for the monthly Digital Contest.  You no longer have to 
compete against the big guns.  Anyone who was competing in or 
qualified to compete in the Advanced Slide Category will auto-
matically be moved into the Advanced Digital Category.  Don’t 
be shy.  Show us your stuff.  Expect to see some really nice im-
ages from our “novice” photographers in 2006.  Everyone has a 
chance to win!

Check it Out on the Web
Mary Lou Reid sent this website in for a product designed to 
clean sensors of DSLR cameras.  It looks very interesting.  I am 
wondering if they can build a really big one to dust my house or 
car.  Here is the link:  http://www.visibledust.com/.

Chips and Salsa for Everyone!
Following HUPS meetings everyone is welcome to join us  at 

Don Carlos Mexican Restaurant for a late dinner.  I know it’s a 

work night, but we won’t keep you out too late.  Don Carlos is 

located on the Northbound 59 feeder road just north of Hillcroft.

Novice Digital 2nd Place Jim Mensay, © 2006
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Important 
Dates
Put them on your calendar

February 6
HUPS meeting - David Len-

derman - Digital Komodo 

Video and Stills, plus wide 

angle tips

April 3 
HUPS meeting - Ken Knezick - 
How to dive successfully (and 
safely) with cameras

May 1 
HUPS meeting - TBA

March 6
HUPS meeting - Joyce & Frank 

Burek - Critiquing images

April 13 - 23
HUPS trip to KBR - Lembeh 

Strait - contact Tom Collier - 

tom@tpixs.com

June 5
HUPS meeting - Christa Lousta-
lot - Red Sea Adventures

Basic Concept of the Month - 

Shutter Speed and f-stop
It is a bit confusing for newer photographers.  How do shutter 

speeds and f-stops relate to each other.  I like the water bucket 

analogy.  You have a bucket that needs to be filled with water.  You 

can either open the faucet wide open for 1 minute or open the 

faucet halfway for 2 minutes.  Or you can use various combinations 

of faucet opening and time to fill the bucket.  EIther way the bucket 

will be properly filled.  In photography imagine the water and 

bucket are light in your image.  You need the right amount of light 

to “fill” your image.  The shutter speed is how long you leave the 

faucet open to let in light.  The f-stop is how far you open the fau-

cet.  Any given image can usually be created by various combina-

tions of f-stop and shutter speed.

In an effort to help educate our less experienced members we will 
try to feature a basic term or concept in each month’s newsletter.  If 
you have an idea for a featured concept or have a question you 
would like answered email it to underh2o@ev1.net.

Quick Tip
When downloading images from your digital camera do 
you use the little USB cable that came with your camera to 
connect it to the PC?  If so, there is an better way.  Buy a 
card reader and connect it to your PC.  Using an inexpen-
sive card reader has several benefits: 1) you don’t use 
camera batteries during the downloading process, 2) you 
minimize the amount of time your housing has to be open 
and exposed,  3) it may allow you to leave the camera in 
the housing while just popping out the card, 4) your cam-
era is available for taking photos instead of being tied up 
downloading.

If you have a tip that would be of interest to other HUPS mem-
bers please send it to David Lenderman - underh2o@ev1.net.



The Houston Underwater Photographic 
Society meets the first Monday of the !
month at 7:00 PM at Bayland Com-
munity Center, 6400 Bissonnet, near 
Hillcroft.  Social time begins at 6:45.  
Visitors always welcome 

http://www.hups.org
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2006 HUPS Officers

President Chuck Jensen   281-446-6070

Vice President  Dennis Deavenport  281-218-6950 

Secretary  Tammy Allyn   281-493-6883

Treasurer  Henry Ragland   713-785-3561

Membership  Jean Himes   281-376-2138

Photo Contest  Paul Levy   713-664-4990

Newsletter  David Lenderman  281-342-5475

TGCC Rep  F. Burek/D. Mensay  936-588-6664

Librarian  John Anderson    281-351-5780

Web Master  Pat Miller   512-218-9213

Workshops  James Wiseman  713-426-1595

Board of  Directors  

Jack Allyn    281-493-6883

Ken Bean    832-607-2518

Frank Burek    936-588-6664

Sheree Fields    281-252-0343

Ken Knezick    713-973-9300

Paul Levy    713-664-4990

Patricia Lin    

Paul McDonald    713-664-1979

Joe Nicklo    281-933-9875

Dennis Vernon                                                281-491-4674

James Wiseman                                                713-426-1595


